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Getting Started 
 

After importing you can start WorldComposer in the Unity menu -> Window -> WoldComposer. 

World Composer uses Bing satellite images and elevation as its source. Bing maps is from Microsoft 

and it is a free service like Google maps. The advantage of Bing maps is that it has no copyright text 

embedded as a pattern overlay into the satellite images. Also the satellite image quality can be even 

better then Google maps. 

Create a free Bing map account 

To be able to access the data you need to create a Bing key, which is free to get. You only need 

registration. The advantage of using a key is that you can make up to 50.000 transactions in 24 hours. 

It is possible to create multiple Bing keys. To create a Bing map account go here: 

http://msdn.microsoft.com/en-us/library/ff428642.aspx 

For ‘Application type’ you need to choose ‘Public Windows app’ or ‘Windows Phone app’. Only 

these 2 options will give your Bing key 50.000 transactions within 24 hours. Otherwise you can only 

have 125.000 in total and after that the Bing key will expire. 

 

After creating the Bing key you can enter it into WorldComposer: 

Click on the ‘K’ (key) button and the key options will foldout. Copy your key from your browser to a 

text editor first, like ‘Notepad’ on Windows. Because copying the key directly from the browser might 

add a new line to the end and then it doesn’t work in WorldComposer. After copying the key to your 

clipboard you can paste it into the text field. The key will be displayed in a red font between the ‘…’ 

behind the text field. 

 

After this click the ‘K’ button again to close the key foldout and press F5 key on your keyboard and 

you are good to go! Now you can scroll around in the WC map, to see the navigation options click the 

‘Help’ tab. If you get the error: ‘…401 Unauthorized’, then your Bing key isn’t working, please check if 

you have any spaces or enters in your Bing key field. If you are in Webplayer build mode check the 

Troubleshooting section at the end of this manual to get WC working.  

http://msdn.microsoft.com/en-us/library/ff428642.aspx


Licensing 

The data can be used freely non-commercial. However the whole commercial aspect is a grey area, 

you can read the discussion about it on the first page of the WorldComposer forum. 

Refresh the map 

The map in WorldComposer automatically refreshes after you scroll around. To refresh the map 

manually press the F5 key on your keyboard.  

WorldComposer GUI interface colors 

These can be changed in the ‘Settings’ tab. In this manual I use the colors that I use for Unity pro. 

WorldComposer on default has different interface colors for the interface to be clear in Unity free 

and Unity pro, because in Unity free the font color is black and cannot be changed. 

  

http://forum.unity3d.com/threads/215485-WorldComposer-a-tool-to-create-real-World-AAA-quality-terrain


WorldComposer upgrade guide 
For the features, improvements and fixes of ever update you can check the WorldComposer Release 
Notes.txt file in the WorldComposer folder. 
 

New in WorldComposer 1.4 

Normalize heightmaps  

Exported heightmaps are now automatically normalized. This can be enabled/disabled in the ‘Terrain 

Create’ tab with the option ‘Normalize Heightmap’. Without normalizing the elevation in meters 

(Bing returns elevation in meters) is converted to a value from 0-65535 (16 bit value that is used for 

the 16 bit raw grey scale heightmap). WC adds 100 meters (because around ocean height can 

sometimes be negative) and then divides the height by 9000 meter, this because there’s no higher 

elevation on earth then 9000 meter.  

With normalizing the heightmap, WC creates another heightmap file with _N added to the name. 

WorldComposer first calculates the minimum and maximum height of the heightmap, then the 

minimum height will be 0 and the maximum height will be 65535. This results in a heightmap that 

uses the complete 16 bit range from 0-65535. Using normalization gives the benefit that it is easier to 

work with both in TerrainComposer (easier to setup up curves and values) and with Unity terrain 

brushes (will respond with more precision). 

 

New in WorldComposer 1.3 

Manual override in ‘Heightmap Export’ tab 

WC calculates the available heightmap resolution at the center of an area, but the heightmap 
resolution can be of a higher around the center within the area. With enabling 'manual' toggle you 
can select a higher heightmap resolution to grab the maximum detail in such area. 
 

Converter from ArcInfo ASCII to raw 16 bit greyscale heightmaps. 
Explained on page 8. 
  



Exporting an area with WorldComposer 
 

Tutorial videos 

I explain in this video how to use WorldComposer, which only take less than 15 minutes to watch.   

http://www.terraincomposer.com/worldcomposer  

After you have the WC map working when entering a valid Bing key you can start exporting areas. 
To export an area you need to activate the following tabs: 
‘Map Parameters’, ‘Regions’, ‘Heightmap Export’ and ‘Image Export’. 

 

Map Parameters 

This tab gives the information about the map (I call this WC map) that is showed in the 
WorldComposer window. In the ‘Map Type’ you can select the kind of map you want to export. There 
are three options: 

 Aerial -> Satellite imagery without labels. 

 Aerial With Labels -> Satellite imagery with labels. 

 Roads -> A road map with labels. 
 
The map type you chose here is the one that will be exported. The ‘Latitude’ and ‘Longitude’ are the 
center of the WC map. You can enter manual values by clicking the ‘E’ (Edit) button, after changing 
you need to press the ‘F5’ button on your keyboard to refresh the WC map. The ‘Zoom’ is the current 
zoom level of the WC map. The ‘Mouse’ is the lat/long (latitude/longitude) values of the mouse 
pointer position on the WC map. 
 

Regions and Areas 
You can create regions which is just a container for multiple areas. You can have an unlimited 
amount of regions and areas in the WC map. Regions (invisible) and areas (visualized) are 
automatically saved in the global_settings.prefab in the WorldComposer/Templates folder. If you 

http://www.terraincomposer.com/worldcomposer


want to reset WorldComposer to default values you can delete the global_settings.prefab. You can 
add/erase regions/areas with the ‘+’ and ‘-‘ buttons. You can change the name of of the region/area 
with the ‘E’ (Edit) button. For a region the lat/long is saved from the center of the WC map from the 
moment you click the ‘+’ button. You can go back to this location on the WC map by clicking the ‘Go’ 
button. The same happens for creating areas. Each area has a lat/long for its center, upper left and 
lower right. You can go to these with the WC map by clicking to ‘Go’ button. If you want to set the 
center of the WC map as the center of the region/area you have to shift click the <Set> button. 

How to export an area and create terrains 
The exporting and creating terrains workflow is easy and fast. Start with a small area with a few tiles 

only, until you are familiar with how WC works. WC has no limitations and trying to create terrains 

from huge amount of data can crash Unity… 

1. Enable the tabs ‘Map Parameters’, ‘Regions’, ‘Heightmap Export’ and ‘Image Export’. 
2. (Optional) Make a new region by clicking the ‘+’ button in the ‘Regions’ tab. You can rename 

the region name by clicking the ‘E’ (Edit) button. 
3. Scroll to your location in the WC map. Click the ‘Help’ tab to see the WC map navigate 

options. 
4. Make a new area by clicking the ‘+’ button in ‘Areas’. Can rename the area name by clicking 

the ‘E’ button. 
5. The ‘Pick’ button in the ‘Area’ tab will become red, click this button to select the upper left of 

your area in the WC map. Click again to select the lower right of your area in the WC map. 
6. In ‘Image Export’ tab choose your ‘Image Zoom’ and ‘Image Resolution’. This determines the 

amount of images that are export for your area. 
7. You can resize you area by clicking the ‘Resize’ button in ‘Areas’ tab. Deactivate it after you 

are done with resizing. 
8. Choose a ‘Heightmap Zoom’ level in ‘Heightmap Export’ tab. This value is automatically set to 

the available maximum, so you don’t have to change this unless you want to export a lower 
heightmap resolution then what is available for that area. To lower the heightmap resolution 
is needed for huge areas (I recommend not to go higher then 4k). 

9. Choose an export path (folder) by clicking the ‘Change’ button in the ‘Heightmap Export’ tab. 
The exported images and created terrain tiles will automatically choose this folder if the 
toggle is disabled behind each file name. If you enable the toggle behind a file name you can 
choose a export path/file name separately for heightmaps/images and Unity terrain tiles. 

10. Click ‘Export Heightmap’ button to export your heightmap or your area. 
11. Click ‘Export Images’ button to export the images of your area.  
12. Active the ‘Create Terrain tab’. Don’t change the ‘Heightmap Resolution’, as it is the 

resolution used for each terrain tile and this is automatically calculated. The manual override 
is for if you want a higher heightmap resolution to create more details manually, but you 
need to know what you are doing as this can have impact on performance/memory usage 
and it needs smoothing, read more about this in troubleshooting section at the end of this 
manual. 

13. Click the ‘Create Terrain’ button. Now WC creates the Unity terrains from your exported 
area. 

 
You can change export settings for each area and re-export it anytime. Each area is stored in the WC 
map, and you can select an area by scrolling to it in the WC map and click on its label. Another way is 
to select it in the Regions/Areas tab and using the ‘Go’ buttons. You can export multiple areas as they 
are queued. An entire region by shift click the ‘Export Heightmap’ and ‘Export Image’ button (control 
click these buttons to stop all exporting).  



Unity’s and Bing limitations 

Please keep in mind that you have 50k transactions you can do within 24 hours with 1 Bing key (you 

can create multiple Bing keys). Exceeding this amount by magnitudes within 24 hours Microsoft 

might block your Bing key. The amount of transactions needed for the heightmap and images you 

can see in the ‘Heightmap Export’ and ‘Image Export’ tab in the size field (threads have been 

renamed to ‘transactions’). The amount of transactions you did with your Bing key you can see in the 

‘Map Parameters’ tab. It can be reset after 24 hours. You can export four high resolution 4k 

heightmap within 24 hours with 1 Bing key. If you are previewing I recommend to use a lower 

heightmap resolution to save on transactions like 1k (48 a day) or 512 (97 a day).  

When you zoom out the heightmap/image resolution will be halved, when you zoom in the 

resolution will be doubled. When zooming with Image Zoom the amount of tiles for the area 

changes, as well as the image size (total image resolution). The amount of terrains (tiles) needed is 

depending on your image resolution and image zoom level. In most cases it is best to use 4096 image 

resolution as most GPU hardware can render 4k images, and using less terrains is faster. Mobile 

hardware can be limited to like 2k. However sometimes it’s better to use 2x2 or 4x4 terrains instead 

of 1 terrain. As the terrains that are not visible will be culled, and that results in faster performance. 

However culling also takes a little overhead for each terrain. So an in between setting like 2- 5 square 

tiles is best. 

 

  



Exporting to Folders 

If you want to export the satellite images or a heightmap to a folder you can choose it with the 

‘Change’ button. If you shift click the ‘Change’ button, it will reset the path to your project/assets 

folder. Be sure to export images inside your Unity project, otherwise WorldComposer won’t be able 

to create terrains from it. If you want to export large areas with massive data for the use outside of 

Unity, it is better to export the image to a folder outside Unity, because Unity won’t need to import 

all the images then. 

 

Convert  ArcInfo ASCII heightmaps to 16 bit raw heightmaps 

With the ‘Convert’ tab you can convert ArcInfo ASCII heightmaps to 16 bit raw heightmaps. The 16 

bit raw heightmap is the format WorldComposer and TerrainComposer can use. More information 

about the ArcInfo ASCII format you can find here: 

http://en.wikipedia.org/wiki/Esri_grid 

http://docs.codehaus.org/display/GEOTOOLS/ArcInfo+ASCII+Grid+format 

 

 

Use TerrainComposer for making splatmaps, placing trees, grass and objects 

A video to place trees with TerrainComposer you can see over here.  

http://www.youtube.com/watch?v=bnuLGAtvTsg 

Click here to take a look at TerrainComposer on the Asset Store 

 

Use Ufs flight simulator engine if you are going to use planes 

I’m collaborating with Chris the developer of Ufs. If you are looking for a realistic flight simulator 
engine, Ufs is the way to go. Chris is a real pilot and owns his own Cessna. 
 
Ufs with its powerful suite of editor tools, complex aircraft can be quickly and accurately modelled, 
rigged and animated with 0 lines of code.  
Highly advanced Flight Dynamics modelling, JavaFoil integration and a library of over 1000 real world 
aerofoils means your aircraft will look, feel and handle just like the real thing. 
 
Click here to take a look at Ufs on the Asset Store 
 
  

http://en.wikipedia.org/wiki/Esri_grid
http://docs.codehaus.org/display/GEOTOOLS/ArcInfo+ASCII+Grid+format
http://www.youtube.com/watch?v=bnuLGAtvTsg
https://www.assetstore.unity3d.com/#/content/7065
https://www.assetstore.unity3d.com/#/content/11321


Use RTP3 Terrain Shader for amazing visual quality 

WorldComposer uses integration with RTP3. I highly recommend using RTP3 terrain shader with 

WorldComposer and TerrainComposer. 

Click here to take a look at RTP on the Asset Store  

I’m collaborating with Tom and he has taken terrain rendering with RTP3 to a whole new level of 
amazing ‘CryENGINE’ quality. Also Tom build a special feature in it for WorldComposer. The feature 
that you can blur satellite images at close distance. This will minimize the pixilation effect while 
keeping maximum quality for far distance. He has been working fulltime for months to get RTP3 on 
the level where it is at now.   
With RTP3 you can use the satellite images as a colormap and mix them with splat textures. This will 
give high visual quality especially for close distance view, because then the ground will have real 
close up detail, instead of a zoomed pixelated satellite image. This way you can make a AAA quality 
first person perspective terrain. Also Tom has solved a material performance issue with multiple 
terrains that other terrain shaders have in Unity4. With this solution RTP renders terrain up to 10x 
faster. 

 
Snow can be easy changed during runtime in RTP3 with and different settings like strength, height 
threshold, reduction by slope. 

 
 
If you have TerrainComposer and choose to use the standard Unity terrain shader you can use the 
satellite images as a splat texture and this way mix them with other splat textures, which will still give 
a lot better quality but cannot be compared with what quality can be achieved with RTP. 

  

https://www.assetstore.unity3d.com/#/content/5664


Fitting the satellite images with the heightmap 
The satellite images do not always fit with the heightmap. After selecting your area you can export 

the heightmap. But before exporting the satellite images, you can first align the satellite images by 

using an ´Offset´ in image export. As for the direction -> +X is putting images to the left, +Y is putting 

images up. You won’t need to export the images for the whole area each time, but you can choose 1 

tile.  

 Disable track tiles in the ‘Settings’ tab, as you don’t want that the image position is changed. 

 You can choose the tile by clicking on the ‘Start’ button and then click on the tile in the map 

you want.  

 Enable the ‘One’ toggle to only export this 1 tile. Otherwise WC will export the images after 

the tile you selected too. 

 Click ‘Export Images’. 

 Create the terrain in the Terrain Tab. 

 Look into the Scene if the images fit the heightmap. 

If the image still doesn’t fit the heightmap, adjust the Offset and export the tile again. You won’t 

need to recreate the terrain, as the image should be updated by Unity after exporting. Repeat the 

process until the images fit. Then click ‘Start’ and select the first tile. Now you can export the images, 

and when finished recreate the terrains in the ‘Create Terrain’ tab. 

  



Image export formats, Jpg and Png 

You can export images as JPG’s or PNG for direct use to create terrains in Unity. I recommend to use 
JPG images as they have the best compression and take the least amount of disk space. Because you 
are dealing with massive data is best to keep the disk size as small as possible.  
 

Image export Raw format 

You can export images with a Raw format to any image size. They can’t be used directly in Unity, but 
then can be converted to Jpg with WorldComposer after you edit them for example in photoshop. 
Also they can be used in external software. 
 

Combining Raw images into 1 big raw file 

You can combine them to one big Raw image in WorldComposer by clicking the ‘Combine Images’ 
button after importing. Then WorldComposer makes a …_combined.raw image in the folder you 
export to. 

 
With this combined raw image you can do shadow removal in the Image Editor. It can also be opened 
with photoshop for editing. The advantage of using 1 file in for example photoshop is that you don’t 
have to worry about non fitting images at borders. If you do shadow removal first, a new image will 
be saved with the name …combined2.raw. So if you do shadow removal you need to open 
…combined2.raw in photoshop, otherwise you have to open …combined.raw.  
  



Opening raw rgb images in Photoshop 
For opening a raw image in photoshop, make sure you have Channel ‘Count’ on 3, ‘Interleaved’ 
enabled and depth on 8 bit. 

 

Slicing raw images to jpg 

You can slice the combined raw image into Jpg images, so that you can create terrains in Unity with 

it. For the ‘Slice Images’ button to appear you need to enable Jpg and Raw. The ‘Resolution’ will be 

used, so you can select your Jpg resolution there. If you change the resolution, you will also see the 

amount of area tiles change. The …combine2.raw file is needed for this in your export folder. So if 

you didn’t used the Image Editor you need to rename the …combine.raw to …combine2.raw 

 

  



Image Editor  

 

Shadow Removal 

Shadow removal works with a color range, which can be defined with the 2 first colors you see in the 
image. Then comes a toggle which is for visualizing the selected color range. This will show in the 
preview image on the right, if you click apply it will save the image with highlighting. The shadow 
removal algorithm will fill the edge pixels around the color range, and you can select the maximum 
color the edge has, if the edge color is brighter it won’t do content fill on that pixel. With the radius 
you can select the radius where the algorithm grabs the pixels from to fill the shadows with. Because 
it won’t fill everything the first time you can choose how many times you want to repeat the process. 
The more times you repeat the better the result, but it will take longer. Repeating of 3-5 is good. 

Trouble Shooting 

Webplayer Mode 

If you are in WebPlayer Mode you will get this error: 

You are trying to load data from a www stream which had the following error when downloading. 

Rejected because no crossdomain.xml policy file was found 

This is because of the protection level, to solve it do the following: 

Unity Menu -> Edit -> Project Settings -> Editor...Then in Inspector change 'Host URL' to 

http://dev.virtualearth.net 

 

The heightmap is looking blockery 

This happens when the exported heightmap resolution is lower than 33 for each terrain tile. You can 

use the ‘Smooth’ button after creating the terrain. The smooth button can be used multiple times. 

Behind the ‘Smooth’ button you can choose the strength and a float value can be chosen here. If you 

export to TerrainComposer you need to smooth in TerrainComposer-> Quick Tools -> Smooth. 

The heightmap of the created terrains  does not exactly fit the satellite images 

Read page 6 of this manual. 

Unity crashes when I try to create my terrain 

Read page 4 of this manual. 

Having any issues questions or feature request? Just contact me at 

Nathaniel_Doldersum@Hotmail.com and I will help you out anytime. 

http://dev.virtualearth.net/
mailto:Nathaniel_Doldersum@Hotmail.com

